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1 General Information 

 About application 

1.1.1 What is MwPharm++? 

MwPharm is clinical pharmacokinetic program used primarily to establish proper dosing 

regimen which is determined by both the population pharmacokinetic parameters from a drug 

database being a part of MwPharm and individual patient physiological parameters. 

 

1.1.2 What are the benefits from using this software? 

The program was designed to: 

- Improve the drug prescription quality 

- Prevent patient intoxication 

- Prevent patient underdosage 

- Reduce the number of measurements of plasma drug concentration 

- Shorten the time spent in the hospital for the patient 

- Simplify the communication among doctors 

 

1.1.3 What is the difference between MWpharm++ and MwPharm 4.0? 

MwPharm++ is a new version of MwPharm 4.0. It is now based on Edsim++ software for PKPD 

modelling, so it is possible to create and add new drugs to the MwPharm++ database easily. 

The ++ version is very similar to our DOS version.  

MwPharm 4.0 vs. MwPharm++: both versions are quite different. The ++ version was designed 

to make the switching from DOS easy. There are same computational results, same hot keys, 

possibility to control the app from keyboard, etc. There is also larger drug database (you can 

find the list here) and it is possible to add new drugs easily. There will also be adjustable output 

reports. We are also working on some extensions, for example app for noncompartmental 

analysis, genetic module, etc. Cystatin C levels can be entered in the future. 
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1.1.4 What is the difference between MwPharm++ and MwPharm Online? 

MwPharm++ is an older, stand-alone version of our product. Switching to online version makes 

it easier for customer to access and work with the software from anywhere in the world. 

There is a significant difference between MwPharm++ and the DOS version 

regarding the effect the GammaSD. That is because MwPharm++ uses 

double precisions matrix and DOS uses single precision. So MwPharm++ 

should perform better. The usual range of GammaSD should be between 1 

and 4. 
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 Registration 

1.2.1 How long is the trial version valid for use? 

Trial version license works for 30 days. You have all components of our software unlocked to 

truly test out our software. After this time period, it is necessary to buy a license in order to be 

able to use the application. 

 

1.2.2 How to get a licence? 

If you decided that you want a license for our software, feel free to email us: 

info@mediware.cz where you will obtain a pricelist with specification on the price and period 

of usage for our software. 

 

1.2.3 How to register to the application? 

You can register to the application by downloading latest version of the software on this link 

https://www.mediware.cz/en/mwpharm-plus-plus-downloads. Use your e-mail to access the 

software features and automatically start your 30 day trial period.  
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1.2.4 How to install the software? 

After downloading the file, run it. If you have an old version of MwPharm already installed, 

the installation will do a complete reinstall. If you want to maintain your current database, 

backup your database file, that is in  

For the installation, proceed as shown in the pictures below. 
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1.2.5 How to check the expiration date of a license? 

After logging in to the application, choose Help – About MwPharm++ and new window 

containing license information will open as in image below. 

 

 

1.2.6 What is Hardware ID? 

Hardware ID is a unique set of characters and numbers to identify your device. We issue license 

to one unique device, so that is why we need to get this information from you. Our software 

allows you to seek this information in no time. 
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1.2.7 Where do I find Hardware ID? 

Open the same window as in 1.2.4 and choose the button Copy Hardware ID.  

 

By following the instructions, you now copied the Hardware ID. Now just paste this to an email 

for us, and we will create a license file for you. 

 

1.2.8 How to install the license? 

Download the license file after receiving a response email from us with the file. Move the 

license file (it has a suffix *.license) into the "C:\Mediware\MwPharm++" folder. Make sure 

you removed the old license files. Now open the MwPharm++ again and do as shown in the 

pictures below. 

Open the window from 1.2.4.  

Choose Install License. 
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 Updates and Maintenance 

1.3.1 Where can I see application version? 

You can find information about current application version in the same window as in 1.2.4, 

where product information is listed. You can compare current version with the latest version 

released on web page https://www.mediware.cz/en/mwpharm-plus-plus-downloads.  

 

 

1.3.2 How often is application updated? 

The application is updated 4 times a year. You can see list of all main realeases at the web page 

https://www.mediware.cz/en/mwpharm-plus-plus-downloads. 

 

1.3.3 Will my database be saved after installing latest update of the software? 

If you want to maintain your current database, backup your database file, that is located in 

"C:\Mediware\MwPharm++\PlugIns\MwPharm\MwPharm.db3" (if the user did not 

change the location where the application is installed). 

 

1.3.4 Do I need to install all the updates? 

You should update your software as soon as possible when a new one is released for the best 

user experience. Every update improves the last version by adding some new features or by 

getting rid of some bugs. You don’t have to uninstall the software, just backup your database 

and run the update. 
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1.3.5 When to do the Back up? 

It is always good to back up your MWpharm++ data before every update, change of database 

or before eventual hotfixes. 

In order to do that, back up the whole folder “C:\Mediware” and also database file 

“C:\Mediware\MwPharm++\PlugIns\MwPharm\mwpharm.db3”. 
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 Support and Contact Information 

1.4.1 How do I contact customer support? 

Directly send comment or question to our client support team support@mediware.cz or 

register on our service desk to get access to help faster 

https://mediware.atlassian.net/servicedesk/customer/portal/3. 

 

1.4.2 What support resources are available? 

We provide customer support via e-mail, telephone, forum and service desk. Register on our 

service desk via e-mail and get the support as soon as possible 

https://mediware.atlassian.net/servicedesk/customer/portal/3.  

 

1.4.3 Are there user forums or community support options? 

Yes, access our MwPharm Forum using Community button as in the image below. MwPharm 

Forum is designed specifically for our users to share valuable insights in software and discuss 

important topics regarding pharmaceutical field. You can also easily access it via this link: 

https://forum.mwpharm.online/. 
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 Training and Onboarding 

1.5.1 Will I be trained to use the software? 

Yes, we provide our customers with training via Workshops. Workshops are usually held online 

and they are defined by the level.  

 

1.5.2 What types of Workshop there are? 

First level Workshop 

First level Workshop is held for beginner users that are getting to know the software.  

Second level Workshop 

Second level Workshop is held for users that need furher, more detailed explanation of software 

use. 

Technical Workshop 

Technical Workshop is set for users that have trouble installing to software, where we provide 

help to the IT team. 

Questions & Answers Workshop 

This type of Workshop is set for users that have defined use area of the software that they would 

like to further discuss.  
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 Troubleshooting 

1.6.1 Bug Report 

If you come across a bug or a fault in our software, please, send us the description of the bug, 

some printscreens of the bugs, the *.edx file of the case the bug appeared in (there are 

instructions for exporting the .edx file below) and most importantly the version of MwPharm++ 

you are currently running. Send the information to support@mediware.cz. All these information 

will help us to solve the bug as quickly as possible. 

 Exporting .edx file:  

- Load the patient and go to the Case tab. In the Case tab, choose the case you want to 

export and click the Export button as shown in the picture. 

 

 

A popup window will appear. In this window, choose the location you want to save the case to. 

Default path is "C:\Mediware\MwPharm++\PlugIns\MwPharm\Cases". Now that you have 

exported the case, you can attach it to the email. 
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1.6.2 How to fix problems with .NET Framework 

There could be a problem happening when windows install new actualizations. To repair this 

problem, first backup your database file. Then use this link that goes to Microsoft Support site 

to a Repair tool, that should help with your problem. If you don’t have .NET Framework 

installed, use this link to install it. 

 

1.6.3 How to recover deleted records? 

The instructions listed below are applicable from version 1.4.0. 

1) Back up the whole app file C:\Mediware 

2) Download app SQLite DB Browser from https://sqlitebrowser.org/ 

3) Open file "C:\Mediware\MwPharm++\PlugIns\MwPharm\Mwpharm.db3" in 

SQLite DB Browser 

4) Select table Drug 

5) Rewrite values 1 to value 0 in column HideDrug (1=deleted, 0=active record) for 

drugs for recovery 

6) Remove number and curvy mark from beginning of the name of the drug 

(6~amikacin to amikacin) 

7) Check table Model and column HideModel (no record should have value 1=deleted). 

If there is such, change the value to 0 (=active record). 
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1.6.4 Errors in Patient tab 

If this error, shown on the photo below, occurs, you didn’t fill in unique patient number 

correctly. The number you filled in is already assigned to another patient. 

 

 

There is also a similar error, that occurs, even though you filled in the unique ID. This error 

means, that you, as a user, don’t have access to write in the database (create a new patient). To 

get access to this, contact your IT department. 
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2 Features and Functionality 

 Understanding Key Parameters 

2.1.1 What does the red mark by the items mean? 

Moving your mouse to the red mark will show you detailed explanation of the parameter 

mentioned or detailes of the possible choices to choose from. 

 

 

2.1.2 How can I navigate specific tabs? 

By clickin on tab name is specific tabs, you will find detailed instructions on how to navigate 

the unique tab. 
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2.1.3 What do the prefixes and suffixes mean? 

The following table shows the meaning of these suffixes and prefixes. 

Prefix / Suffix  Meaning  

C1, C2, C3  number of compartments in the model  

child, adult, neonate  specifies the use of the model for the age of the patient  

0-0.5m,0.5-1m,1-6m, 6-12m,  

1-5y, 5-10y, 10-16y  

specifies the use and range of the model for the age of the 

patient (m – months, y – years)  

prefixes like !, # etc.  these models have different studies backing them up then 

our base models  

cf  cystic fibrosis  

ic  intensive care  

k  elimination rate constant  

capd  continuous ambulatory peritoneal dialysis  

 

2.1.4 What does C1, C2 and C3 mean? 

The C stands for compartment and the number by the letter stands for the number of 

compartments that are included in the model. 

 

 

2.1.5 How to create a new user? 

To create a new user, log in as an Administrator. Visit section Users and fill in the green boxes 

and select Level of the user. Then you click Insert to insert a new user and Update in order 

to update the database. You can also use Update if you are only updating user information. 

You can also delete any user you want, except the last administrator account. 

Beware, that we can’t restore your password. If you forget the password to your only 

administrator account, you would have to reinstall your software. 
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2.1.6 What is the difference between different User Levels? 

Our program has 4 default types of users: Administrator, Super user, Normal user and Guest. 

The differences between these are shown in the table below. 

Screen Feature Admin Super User Guest 

Edsim All (params) + + - - 

Settings All + + - - 

Users All + - - - 

Case Edit drugs + - - - 

Edit models + + - - 

Edit cases + + + - 

Other 
See personal information + + + - 

Other + + + + 
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 The account logins are as follow: 

Level Username Password 
Administrator admin admin 

Super user super super 
Normal user user user 

Guest guest guest 

 

2.1.7 How to change User password? 

In order to perform such actions, you must log in as the admin and open section Users. You 

can delete users in the same tab or change their password simply by highlighting and typing a 

new password for the selected user and afterwards updating the database by clicking on 

"Update". 

We recommend that, before altering the user, you back up the whole application folder 

(C:\Mediware) - if something goes wrong, you can than restore whole version to the state before 

the change. 

The same actions can also be performed by SQL database browsers, such as DB browser for 

SQLite. 
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 Settings 

2.2.1 How can I change the basic default units? 

Go to Settings – Application Settings and there you can decide which units you prefere to use 

as default for each of the parameters. 

 

 

2.2.2 How can I change the basic default unit of concentration for chosen model? 

Unit of concentration can be changed in Application settings, as mentioned in 2.1.2. 

 

2.2.3 How to change the localization? 

To change the localization of our software, you need to go to Setting and to the section General 

settings and there you can see an option, to change the language. Choose the language you want. 

 

A LocalizationKit (http://www.mediware.cz/LocKit++1.37.664.zip) can be used for translation 

of other parts. 
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2.2.4 How to change Bayes settings? 

To change Bayes settings, go to the Settings tab and scroll down to the Bayes Generator area. 

There you can change both parameters for Bayes. 

 

If you want to know more information about Bayes, go to the Fitting tab and move your 

cursor to the red arrow next to the Fitting title. 
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 Database 

2.3.1 How to use a shared database? 

First, you need to install a client of MwPharm++ on each device. Now, find the database, you 

want to use. The default route to the database is 

“c:\Mediware\MwPharm++\PlugIns\MwPharm\”. The database file name is 

“MwPharm.db3”. 

Now you need to copy the database filed to the shared drive or server and enable read and write 

rights for the users and applications, that will be using this shared database. 

Now you need to set the connection string in the Settings tab of MwPharm++. Change the 

location or even access rights. 

 

 

 

mailto:info@mediware.cz
http://www.mediware.cz/


 
 

 

Strana 27 z 78  
Mediware a. s. | Na Viničních horách 1834/24 | 160 00 Praha 6 | info@mediware.cz| www.mediware.cz | IČ: 26739488 | 
DIČ: CZ 26739448 | Česká spořitelna a.s.| číslo účtu: 9231462/0800 | Spisová značka B 8009 vedená u Městského soudu v Praze. 
 

 

2.3.2 Database missing or invalid connection string 

This could possibly occur after upgrading the software version. Follow the procedure below. 

1) Settings >> Database settings 

2) Connection string should be as following: Driver=SQLite3 ODBC 

Driver;Database=C:\Mediware\MwPharm++\PlugIns\MwPharm\MwPharm.

db3;FKSupport=True; 

If access to Database settings is not possible, do the following: 

1) Back up file "c:\Mediware\MwPharm++\PlugIns\MwPharm\MwPharm.cfg" and 

delete that file 

2) This file contains settings for connecting to database and if deleted, the app will 

automaticaly create a new default one 

Do not forget to back up your database before each upgrade. 
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 Patient 

2.4.1 How to add a new patient? 

To create a new patient, you need to go to the Patient tab and fill out the rows. In order to 

successfully create a new patient, it is mandatory to fill following information: Patient 

Number, Date of Birth and Sex.  

 

After you fill out these rows click Insert to create a new patient in your database. 

Now you can go to the tab Status. Here you can change other attributes of your patient. To save 

your progress go back to the tab Patient and click Update. 

 

2.4.2 How do I access the patient I have been working with before? 

In section Patient you can see the list of all your patients and choose the one that you would 

like to continue to work with. Click Load to load the selected patient.  
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2.4.3 Do I have to fill in personal patient information? 

While entering patient data, user can also fill in personal and sensitive information, but this is 

not required for the application calculations. Personal information such as first name, last name, 

e-mail, phone number, and address can be filled.  

 

2.4.4 What do buttons under Patient List mean? 

STANDARD: it will create a standard patient (male, 55 years old, 70 kg, 175 cm) BUT you 

still need to click insert to add him to the database 

LOAD: will load your chosen patient 

ACTIVE: if you loaded a patient and unmarked him in the database, you can mark him back 

by clicking this button 

DELETE: will delete your chosen patient 

UPDATE: will update your patient information e. g. address, physician, status, case etc. 

IMPORT: enables to import cases that are not in your database yet 

 

2.4.5 How to define patients’ medical condition? 

Defining patients’ medical condition is necessary for the software to make individual 

calculations and it is done using the tab Status after creating a new patient. Weight and height 

are mandatory fields, you can also specify other patient parameters such as body constitution, 

sex and race which will help in specification of the dosing. 

Don’t forget to insert patients’ creatinine clearance in the tab Status too. 

 

 

mailto:info@mediware.cz
http://www.mediware.cz/


 
 

 

Strana 30 z 78  
Mediware a. s. | Na Viničních horách 1834/24 | 160 00 Praha 6 | info@mediware.cz| www.mediware.cz | IČ: 26739488 | 
DIČ: CZ 26739448 | Česká spořitelna a.s.| číslo účtu: 9231462/0800 | Spisová značka B 8009 vedená u Městského soudu v Praze. 
 

 

2.4.6 What does Renal function field serve for? 

Organ function is very important field since its purpose is to define the value of creatinine 

clearance. This parameter is calculated from the inserted serum creatinine value based on the 

renale function that the user chooses. User can decide between 14 offered renal functions, as 

well as the option user-estimated creatinine clearance. 

 

2.4.7 What is the difference between Jelliffe “renal functions” in Status card + 

Schwartz children formula? 

JelliffeⅠand JelliffeⅡare two methods published by Dr. Jelliffe. The equations are following: 
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The Jelliffe Ⅱ-2 serum creatinine levels method is suitable for calculating the creatinine 

clearance in case of an instable kidney function. It is the only method that takes the non-renal 

creatinine clearance into account with patients suffering from a chronic kidney disease.  

The net creatinine production is only dependent on Ccr levels in case of Jelliffe 2.  

The Schwartz children formula is only available if the subject is younger than 20. 

 

2.4.8 What is the difference between Simplex and Marquardt method? 

The Simplex method calculates without standard deviation. The Marquardt calculates with 

standard deviation. 

 

 

 

 

 

 

 

 

 

 

mailto:info@mediware.cz
http://www.mediware.cz/


 
 

 

Strana 32 z 78  
Mediware a. s. | Na Viničních horách 1834/24 | 160 00 Praha 6 | info@mediware.cz| www.mediware.cz | IČ: 26739488 | 
DIČ: CZ 26739448 | Česká spořitelna a.s.| číslo účtu: 9231462/0800 | Spisová značka B 8009 vedená u Městského soudu v Praze. 
 

 

 Case 

2.5.1  How do I create a new case? 

Once you have created a new patient or opened details of the old one, go to the section Case. 

First, choose the drug substance you want to work with and later on choose the specific drug 

model. Once you have made your choise click Insert in order to create a new case.  

 

 

2.5.2 How do I decide which drug model to use? 

While creating a new case, you can choose the medicine that you would like to apply to your 

actual patient. You can choose the medicine from Drug model list, which contains about 180 

different drugs, and around 300 models altogether. 

You can choose the model based on the characteristics of your patient or on the litareture that 

the model was created by.  

For example, vancomycin for adult, neonate or dialysis patient. 
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2.5.3 How to extract several cases or models at once? 

You can extract cases using our DatMan application. You can find the application following the path: 

"C:\Mediware\MwPharm++\DatMan\DatMan.exe". 

 

 

 

If you open DatMan, the following window will show up: 

 

 

In the row Data Source, you can choose the database. The default setting is: "Driver=SQLite3 

ODBC 

Driver;Database=C:\Mediware\MwPharm++\PlugIns\MwPharm\MwPharm.db3;FKSupport=Tr

ue;". 
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You can also choose the file manually by clicking on the button with dots on the same row. 

The row Drug Filter is for specifying the name of the drug used in the cases or models you 

want to export. The wildcard character is %. For example, phrase "genta%" gives you all types 

of models which name starts with the phrase "genta". 

If you then hit the button Filter Cases, an Excel sheet will open. In this sheet, there is list of all 

cases in which the selected drug participates. If you hit the button Filter Models, the list of 

models with the selected name will be created. For example, for the data source "genta%" the 

list can look as in the following pictures: 

 

 

You can edit the list of cases or models before extracting, just don’t forget to save the changes. 

Now, if you hit the Extract button, a window will pop-up. In this window, choose the created 

file Cases.xlsx or Models.xlsx. After that, a new folder containing selected cases or models 

will be created. You can find it in the same folder as the selected *.xlsx file. 
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2.5.4 How to export / import patient case? 

In order to share an information about a certain MwPharm++ case with other user, device or 

lab you can export the case from the history tab. Load the patient which should be exported, 

go to History tab of the case and use EXPORT button as shown below. 

 

Save the case into the desired folder in your computer. 

Default folder: C://Mediware/MwPharm++/PlugIns/MwPharm/Cases 

You can import a case by clicking IMPORT button in the Patient tab of MwPharm++. Click 

Import and choose the case which should be imported from the appropriate folder. 
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2.5.5 How to move case from MwPharm++ to MwPharm Online? 

Go to the Patient tab and load the case you want to move. Then go to the History tab and 

click the button Export as shown in the picture. 

Now, a “Save as” window will pop-up. In this window, choose a name of the exported file and 

a location you want to save it to and hit the Save button. The default path is 

“C:\Mediware\MwPharm++\PlugIns\MwPharm\Cases”. 
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Log into MwPharm Online and go to the Cases tab on the left. Now, click the button Case 

import in the upper part of the page. 

 

A new panel will appear in the right part of the page. In this panel, either drag the case you 

exported in the 2nd step into the gray field, or hit the button Select files… and choose the desired 

case manually. 

 

 

After selecting the desired file, the file is uploaded. There should appear the name of the case 

together with a confirmation that the upload of the file was successful. The last step is to hit the 

button Import case below in this panel. Now, the case should appear in your MwPharm Online 

database. 
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2.5.6 How to move the case from MwPharm Online to Mwpharm++? 

Log into you MwPharm Online account and go to the tab Cases. Choose the case you want to 

move and go to the Simulation tab. Hit the button Export in the right upper corner. 
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In the right side of the page, a panel called Export will appear. In this panel, switch to the 

Export to EDX tab. 

 

Hit the button Export to EDX below in the panel. The chosen case will be downloaded 

automatically. 
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Log into your MwPharm++ application and go to the tab Patient. In this tab, hit the button 

Import in the right below corner as shown in the picture. 

 

A popup window will appear. In this popup window, you can choose the downloaded file. The 

default folder the exported files download to is Downloads. After choosing the desired file and 

clicking the button Open, the case should be stored in your MwPharm++ database. 
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 History 

2.6.1 What parameters can I insert in History? 

History section allows the user to have overview of loading and maintenance dose, that are 

specified by the application. User can insert specifical parameters for the actual patient such as 

changes in weight, drug concentration from the blood sample, creatinine, liver function and 

values specific for dialyses.  

 

2.6.2 How to copy history between the models? 

In MwPharm++ we have two ways how to copy history between the models. 

Go to the History tab, where is your preferred history. Click the left button on the first line of 

the history and drag your mouse labeled everything you need. Then click the right button on 

the highlighted area and select Copy. 

 

Go back to the Case tab, choose another model with which to compare the previous model and 

click to the Insert button. 

 

You will be automatically brought to the History tab. Press Ctrl+V keys simultaneously or 

right click on the first line of the history and select Paste. 
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The second way would be to instantly copy model in the Case tab. In the left window, select 

the model which history you want to copy. In the middle window, select the model to which 

you want to copy history and press Copy. 

 

2.6.3 How to export model with History 

To export the model with History, go to the History Tab and click Export, as shown below. 
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2.6.4 Why isn’t PO/IV option showing in the History Tab? 

This happens, when the model of a drug doesn’t have the needed constants (i.e., bioavailability, 

absorption rate) to simulate either of the options. 

 

2.6.5 How to change units of concentration in the History tab? 

You can change units right in the History tab by clicking on the box with the unit and choosing 

the preferred one from the list. This way, the unit will be changed only in the current case. 
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 Dosing 

2.7.1 How to generate a dose? 

New dose can be generated based on concentration or AUC24 parameters. Each of these require 

the user to choose wanted targeted value for each parameter.  

 

 

2.7.2 What does Practical mean? 

MwPharm automatically calculates the Exact dose for you actual patient, which is often hard 

to implement in clinical setting. For this reason, we offer 4 Practical dosing regimens, that are 

easy for pratical clinical realization.  

 

Each of these dosing regimens has specified values, that can be modified by user directly. After 

choosing your prefered dosing regimen choose the button Add to the history. 
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2.7.3 How to set loading dose to NONE? 

In order to set loading dose to NONE, choose None for parameter Load in Dosing section. See 

photo below. 
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 Simulation 

2.8.1 How to change scaling of a graph 

Below the graph you can find commads for graph scaling. 

 

 

2.8.2 How to add another curve? 

In order to add a new curve to the graph, you can choose from the parameters automatically 

shown next to the graph, as in the photo below. To show any of the graphs, check the box. 

If you would like to add parameter that is not listed on a default screen, choose one of the field 

parameters and click on Select button. Choose the desired parameter from te list. After that, tick 

off the white checkbox next to the name of the parameter to plot the parameter in the graph. 

You can also change the color of the curve by clicking on the color box next to the checkbox. 
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2.8.3 What are the individual checkboxes in Simulation tab good for? 

 

Checkbox  Meaning 

Conc  Shows the concentration of the drug  

MIC  Minimum inhibitory concentration  

AUC(C)  Area under curve (cumulative)  

CI Confidence interval  

SD  Standard deviation  

AUC24/MIC  Area under curve normalized to 24 h divided by MIC  

Ccr  Creatinine clearance rate  

Bsa, Lbmc, Bw  Body surface area, lean body mass, body weight  

eGFR(n)  Estimated glomerular filtration rate (normalized)  

Total  Shows the doses used  

POP  Shows concentration level for population  

Time  Shows vertical time lines for better reading from graph  
 

2.8.4 What does POP check box mean? 

Checkbox "POP" will show the curve based on POPulation data. When user goes back into 

simulation tab after fitting, the program will use the most accurate available data (fitted 

individual parameters). However, if the user wants to see how the curve looks based only on 

population data, use the check-box “POP”. 
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2.8.5 How to determine the concentration at time X? 

Time cursor can be moved by clicking on the arrows below the graph. One arrow for minimal 

time step, two arrows for bigger time steps. The concentration value at a selected time will be 

shown on the parameter bar on the right side of the simulation tab. 

 

 

2.8.6 How can I set the parameters in the Simulation tab as they used to be? 

In previous versions, there used to be a default layout of the parameters visible in the Simulation 

tab. In order to allowing users to creating their own layout, we removed the default one. You 

can return to the old layout by clicking the key Shift + the button Load upper in the screen.  
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2.8.7 Why is graph staying at zero? 

This can happen if you have not given you model an absorption rate constant. That means, that 

the constant will be zero by default. If the absorption is zero, the drug is not absorbed, and the 

concentration stays at zero. 

 

This was a change made in one of the previous updates. Some drugs have default absorption 

rate at zero, because it deeply varies in various drug applications in per oral use. If you know 

the absorption rate for the drug and application, just change it in the model tab to wanted value. 

 

 

mailto:info@mediware.cz
http://www.mediware.cz/


 
 

 

Strana 50 z 78  
Mediware a. s. | Na Viničních horách 1834/24 | 160 00 Praha 6 | info@mediware.cz| www.mediware.cz | IČ: 26739488 | 
DIČ: CZ 26739448 | Česká spořitelna a.s.| číslo účtu: 9231462/0800 | Spisová značka B 8009 vedená u Městského soudu v Praze. 
 

 

2.8.8 How to view unlimited number of days on the X axis in MwPharm++? 

If you see only 25 days (for example) in simulation, even though you know the total number of 

days in your simulation is over 50, try the trick with adding the patient's weight to history at a 

time beyond the visible range. In our case at 50 days. Use the last inserted weight. 

If this trick does not work, check your model settings. 

The process is simple, if you have loaded a specific model where the error occurs, then flip the 

MwPharm tab to the Model tab in the upper left corner. Now you see a model of drug. Double-

click on the TCompartment block. It opens bar on the right side, where you have to click on the 

Sim tab. Here, make sure that the Duration box is set to 0 h. Because if there is for example 600 

h, you will only see 25 days in the simulation. 

The picture below shows the location of the Duration box. 
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2.8.9 How to obtain complete simulation data? 

When you click to Save button in the Simulation tab of MwPharm++, you can save simulation 

as .CSV data file. Save this file to your computer a then open in Excel. Here you will see all 

times and all concentrations of simulation. 

 

 

2.8.10  Is it possible to show unbound concentration in Simulation tab and how? 

Yes. To show the unbound concentration in Simulation tab, follow the instructions: 

• Load a case and go to the history screen  

• Go to Model tab 

• Enable the observation of parameter C01.Cu variable 
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Go back to MwPharm tab to Simulation screen and you will see a new chart in view: 

concentration unbound 
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  Fitting 

2.9.1 What is the purpose of fitting? 

Fiting section enables the user to fit the simulation of the drug model based on population to its 

specific patient. This will lead to individual specified simulation. Fitting is done automatically 

with use of mathematical functions based on scientific literature. After saving the fitting, 

simulation curve will change. The photo shows simulation based on population with dashed 

line and new fitted simulation with continuous line. 

 

2.9.2  Fitting from one point 

Option A - with Bayes:  

 

We recommend this option in 95% of cases. First, you should try tick off fitting using Bayes, 

if it isn’t selected and press Fit. If you have a new model, you will be offered if you want to 

generate Bayes or not.  
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Option B - without Bayes:  

 

If you would like to fit the model from one point without Bayes, error message will appear in 

the lower right corner. It is therefore necessary to reduce the number of fitting parameters. The 

number of fitting parameters can be reduced when you select Fixed in the column Type.  

 

In case you want to fit all the selected parameters, you must increase the number of 

measurements of the concentration. You have to have at least the same number of 

measurements, as you have fitted parameters. 
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2.9.3  What is the difference between fitting with or without Bayes? 

The Bayesian method combines a priori information (population data) with a posteriori 

information (one or more measured concentrations) for finding the statistically most likely 

values of the individual parameters. The number of non-Bayesian can never exceed the number 

of observations. That means that fitting using just one measured concentration point can be 

done with a model containing maximally one non-Bayesian parameter. 

What is the purpose of the table called “Drug Model” on the right side in the Fitting tab? 

There are two buttons in this table: Store and Load. 

By clicking the button Store, you can save the parameters you set for the model so that the 

future models will be automatically based on these parameters. 

By clicking the button Load, you can load back the population parameters we set for the model 

by default. 

Note that this table is visible for users of the type “Administrator” or “Super user”. Users of the 

type “Normal user” does not have the right to change drugs and models. 

 

2.9.4 What does it mean ‘Matrix is singular’? How to make matrix non-singular? 

A typical cause for singular matrices is over-parametrization, in which an infinite set of 

parameter values can result in the same value of the Objective Function. For example, you 

cannot fit both bioavailability F and volume of distribution V. 
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2.9.5 How to compare 2 graphs? 

You can change the colour of the curve by right-clicking on the red square and choosing a new 

colour. 

 

After that, click the Save button and a window will pop-up. Click OK to confirm and now 

popup a window where you name save the curve to a folder of your choice. 
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Now, you can upload a new patient or modify the parameters of the current patient. Again, you 

need to go to the Simulation, where you will see a new red dosing curve. After that, click the 

Load button, find your formerly saved curve and click OPEN to confirm. 

 

Now you have successfully added another curve. 
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   Drug models 

2.10.1  How do I find the information about the sources of the models? 

To find this information, you just need to go to the Case tab and select the model you want to 

find the information about. Above the model, there is a green row called Description, where is 

the information about the sources. 

 

 

2.10.2  How to import a new model to your database? 

In Drug models section choose Import model – Select from MwPharm Library, where you 

can select your model of choice. The other option is to upload file of a model. 

 

2.10.3  How to add a new model? 

At first you need to go to the Case tab in MwPharm++. After that go to the left column and 

choose the name of the drug you want to assign the model to. In case you want to assign it to a 

new drug, write the name of your medicament in the upper green box and click Insert. You 

might have to click the button Insert twice to confirm the process. The procedure is shown in 

the picture. To assign the new model to an existing drug simply choose the drug from the left 

column and proceed to the next step. 
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After that, click the Import button in the middle and a window will pop-up. There you can find 

the model you want to add to your database. Select it and click Open. 
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Now that you have the model inserted, you can rename it. To rename the model, you just write 

the new name in the upper green box and press Enter. After that you choose the model, you 

want to update, select it and click Update. 

 

Now you have successfully added a new model to your database. Now you can use it like you 

normally would. 
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As you can see above, our software informs you, that you have successfully 

updated your patient. 
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2.10.4  How to change model parameters? 

Choose the model in Drug models and press button Copy model. A copy of your model will be 

automatically created in the database (e.g. YourModel_C1_COPY). You can now use the Open 

model details in the roll out window to open the model editor. Go to Parameters section in 

order to change any parameter values. 

2.10.5  Is it possible to work with drug interaction in MwPharm Online? 

The software is ready for this implementation, but currently there are no drug-interactions 

models available in the default database. If you have data and parameters for drug interaction, 

you can model this in Edsim++ using special interaction building blocks. 

 

2.10.6  How to change units of concentration in the settings of the model? 

After login to the MW++ software click on “Model” bar (upper left corner). 
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Click on „Open model diagram“.
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Find and open the model (folder of all models: 

C:\Mediware\MwPharm++\Models\EDX\MwPharm). 

Double click on „C01 T Compartment “. 

 

A window on the right side pops up => click on “Var” bar on the lower side of the window. 
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Select the unit for „C01.C“ parameter. 

 

Finally, save your model. (either “Save as” to create new model with different units or rewrite 

your model by simply clicking on “Save”). 
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If you choose “Save as”, save the new model to your desktop or elsewhere accessible. To use 

the model in the MwPharm++ software import it as instructed in our FAQ. If you do so, don’t 

overwrite the original model - click on “No”. The newly added model will be named as the 

“original_one~1”. You can rename it as desired in the upper “Model” cell. Afterwards, click on 

update to change the name of the new model in the MwPharm++ database. 

 

 

If you change the units to any variant including mols, be sure to check if the “Molecular weight” 

is input (visible after double click on “C01 TCompartment”, viz pic 4 in this chapter). 
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  Reports 

  How to create a new report? 

Each section in MwPharm enables user to print out a specific report. Use button P to get a print 

of the screen or button R to get a report from a specific tab.  

 

 

 

mailto:info@mediware.cz
http://www.mediware.cz/


 
 

 

Strana 68 z 78  
Mediware a. s. | Na Viničních horách 1834/24 | 160 00 Praha 6 | info@mediware.cz| www.mediware.cz | IČ: 26739488 | 
DIČ: CZ 26739448 | Česká spořitelna a.s.| číslo účtu: 9231462/0800 | Spisová značka B 8009 vedená u Městského soudu v Praze. 
 

 

2.12.1  How to change the Export Templates and Reports? 

At "C:\Mediware\MwPharm++\PlugIns\MwPharm\Reports\Template", you can find the excel 

sheets for reports. There you have five different files, each of which contains the report 

templates for each tab in MwPharm++. You can change each file, as you want your final report 

to look like, but you need to pay attention to width of the excel final form. 

The Excel sheet is using macros, which take data from MwPharm++ and put it in your final 

Report. To see, what macros are available, open the same folder and you can see 

@References.xls, which contains a list of all macros. If it is too challenging to work with 

macros, write an email us and we will happily prepare a template for you. 
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3  Edsim 

  What is Edsim and what is it good for? 

Edsim is our software for creation of new models or for tweaking and updating old ones, that 

are later used in MwPharm++. Edsim is part of MwPharm++ software and can be used ed. 

 

  How to add albumin as patient variable? 

There are two ways for adding covariates to model. 

 

1) Classic MwPharm style using the Allometry field where you can specify a patient 

variable like Bw (requires a TPatient object). The number of patient variables is predefined and 

therefore limited. E.g., there is no albumin. 

2) Advanced Edsim style using the Covariate field where you select a generic covariate 

(requires an XTool object). With this method we can add new covariates which are not defined 

in the patient object. We typically use the following to objects: 

XObserved: Allows us to store a set of observed covariate values XScaler: Defines a 

covariate scaler formula 

Both methods (allometry and covariates) can be combined. Furthermore, multiple covariates 

can be chained. 

  

 

 

mailto:info@mediware.cz
http://www.mediware.cz/


 
 

 

Strana 70 z 78  
Mediware a. s. | Na Viničních horách 1834/24 | 160 00 Praha 6 | info@mediware.cz| www.mediware.cz | IČ: 26739488 | 
DIČ: CZ 26739448 | Česká spořitelna a.s.| číslo účtu: 9231462/0800 | Spisová značka B 8009 vedená u Městského soudu v Praze. 
 

 

You might need to tick off the Show all types checkbox: 

 

A model taking albumin into account may look like this: 

 

It is important to set the correct external in XScaler (default Bw, must be changed to Factor). 

 

With the clearance parameter of the ME object P.Bw is used an allometric scaler and 

AlbuF.CoFactor as a generic covariate. 
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You can enter albumin observations in XObserved object: 

 

The XScaler object has two modes (Opt tab): 

Absolute: CoFactor = Scaler.Value ^ Expo 

Relative: CoFactor = (Scaler.Value / Scaler.PopValue) ^ Expo 

 

  How to add Peritonela dialysis (PD) into model parameters? 

Peritoneal dialysis is not present in the default settings of the model. To add PD into your model, 

go to EDSIM++ (or model section in MwPharm++). Add a new Elimination object (drag and 

drop; 1) and connect it to Patient. Then select TPeriDialysisP in the TYPE section (2). Finally 

change the name of the object to PD (3). 

mailto:info@mediware.cz
http://www.mediware.cz/


 
 

 

Strana 72 z 78  
Mediware a. s. | Na Viničních horách 1834/24 | 160 00 Praha 6 | info@mediware.cz| www.mediware.cz | IČ: 26739488 | 
DIČ: CZ 26739448 | Česká spořitelna a.s.| číslo účtu: 9231462/0800 | Spisová značka B 8009 vedená u Městského soudu v Praze. 
 

 

 

If you double-click on the TPeriDialysisP object, a new section will open on the right side. In 

this section, you can change parameters of peritoneal dialysis. You can change the tab in the 

below part of the section. 

 

Now, go back to the History tab in MwPharm++. You can find the PD option in the routes of 

administration (Roa) column. 
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  What is KinPop? How can I use it? 

KinPop++ is a very easy to use PKPD population modeling tool that integrates well with 

MwPharm++. It is a part of Edsim++ software. With KinPop, you can fit your model parameters 

so that it fits to your population data. KinPop is especially useful for adjusting the basic model 

to the special needs of your patients in specialised units of care after you already gathered some 

data. Also, it is a useful tool for adjusting the model to a different population. 

To use KinPop tool, start Edsim++ and select the model which parameters you want to adjust 

as shown in the picture. Make sure the structure of the chosen model corresponds to the 

population you want to use it for. In the example above, tobramycin_icu_C1 model was 

selected. 

 

After selecting the model, you need to select the dataset you want to use as your new population. 

First, export cases you want to use from MwPharm++ (see FAQ – numbers 58 and 56). Then, 

go to the KinPop tab above (step 1), and choose the Project tab below (step 2). Now, click the 

button with two dots. A window will pop up in which you can choose a folder with a dataset 

you want to use. You can further omit some cases using the checkboxes on the left side (step 

4). Buttons on the right side are for checking all or none of the cases (step 5). In the example, 

the default example dataset was used. 
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Now, that you have selected your dataset and the model, please go to the tab Fitting (step 1). 

Here, you can adjust the parameters you want to get fitted. You can also set correlations in the 

tab Correlation. Then, click the button Start (step 2). 
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By clicking the button Start, you started the fitting. This may take a long time depending on the 

amount of your data, and on the parameters of your computer. Once the simulation is done, a 

message “Ready!” appears in the right bottom corner (step 1), new values of parameters are 

calculated (step 2), and a graph visually representing closeness of each chosen case to calculated 

values (step 3). If you click the XLS button (step 4), you can generate Excel file with results of 

the fitting. 

 

At the bottom of the page there are tabs #Log, #Pop, #Pat, and #Sim. 

 

Tab #Log, contains analysis logs. You can find here information about how the calculation of 

individual parameters went over individual cycles. The process of convergence of the parameter 

to the result value is shown in graphs. 

In tab #Pop, there is a comparison of individual and population values, correlations, 

covariances, and statistical characteristics of the dataset. There are also graphs characterizing 

goodness of fit and weighted residuals. 

In tab #Pat, there is information about individual patients (part Patients), their fitted parameters 

together with values (like median or mean value) characterizing them as a dataset (part 

Parameters), statistical characteristics of each patient’s values (part Statistics), and observations 
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made in individual cases together with values characterizing how far from calculated values are 

individual observed values (part Observations). 

In tab #Sim, there are results of the simulation for individual cases. 

 

In the table below, you can find the most important abbreviations used in KinPop: 

Abbr. Meaning Abbr. Meaning 

LL Log-Likelihood. MPE Mean Prediction Error (bias). 

OBJ Objective function. MDPE Median Prediction Error (bias). 

AIC Akaike Information Criterion. MAPE 
Mean Absolute Prediction Error 
(precision). 

BIC Bayesian Information Criterion. MDAPE 
Median Absolute Prediction Error 
(precision). 

WSS Weighted sum of squares. RMSE Root Mean Squared Error (precision). 

WSSm Weighted sum of squares (observations). Cest Predicted concentration. 

WSSp Weighted sum of squares (parameters). Cobs Observed concentration. 

WSS/df Mean weighted sum of squares. Cvar 
Predicted (est) or observed (obs) 
concentration. 

SD Standard deviation (population). CN Matrix Condition Number. 

SE Standard error (sample). DET Matrix Determinant. 

PE 
Prediction error (as weighted residual or 
relative prection error) 

  

 

The most important formulas are as follows (obs – observation-based weighting, est – 

estimation-based weighting): 
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The list of most important abbreviations and formulas used for the computing can be also found 

in the tab Ref. 
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 Others 

3.5.1 How to define theta value in our software? 

The THETA values are the population means. You must check the Pop checkbox when entering 

these values. The OMEGA is associated with the standard deviation. 

Pop(i) = THETA(i) 

Sd(i)  = THETA(i) * Sqrt(OMEGA(i,i)) 

 

3.5.2 Two modes in the X Observed object (Obj tab). What is the standard mode? 

What is the NonMem mode? 

This is just a different way of parametrizing the covariate. If you click on the Code button in 

the Obj tab you can see how this is done: 

Standard : CoFactor = Factor (Factor >=0) 

NonMem : CoFactor = (1 + Factor) (Factor >=-1) 
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